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(18PR) Capstone Project Instructions 
Last Changed: 8/20/2020 
 

This project consists of THREE PARTS to be completed on your PC/MAC and uploaded into your 

EagleOnline/Canvas course to be graded by your professor: 

• Part 1 - PPT Project: This project includes a PPT presentation based on the topic provided to you by 

your instructor.  

• Part 2 - WORD Project: This project is based on Word modules. 

• Part 3 - EXCEL Project: This project is based on Excel modules.  

 

Perform the steps in the order listed. Check your work before submitting  

(Print this sheet if needed) 

NOTE: Make sure to view the (18PR) PPT Sample Solution.pdf link within this module to get some ideas on 

how to incorporate the features listed below into a PPT presentation. 

Steps Part 1 - PPT Project Instructions Points 

1.  

Create a new PowerPoint presentation file on your PC (or flash drive) named 

18PR_ppt_LastFirst, where LastFirst is your actual Lastname and Firstname (For example, if 

your name is Mary Smith, you will name the file 18PR_ppt_SmithMary) 

1 

2.  

TOPIC for PowerPoint Project ➔ Check with your Instructor 

Some rules to follow in creating your presentation along with some suggestions: 

a. Do not use foul language (keep it clean) 

b. Do not make sexual innuendoes 

c. Keep it “G-rated” (something you could have kids to read) 

d. Try to “teach” or “inform” 

1 

3.  Presentation should contain no less than 10 and no more than 20 slides. 1 

4.  

Use a template or a theme. 

For Templates: Click on File/New, and then you can select PowerPoint presentations and slides, 
Sample Templates, or you can enter a module in the “Search Office.com for Templates” box to 
search for various templates (though that will also give you invitations, and all sorts of other 
things) 

2 

5.  

Use at least 3 slide layout choices. You must use at least: 

a. 1-Title Slide (this is to be your first slide) 

b. 1-Title and Content Slide 

c. 1-Two Content Slide (any type of two content slide) 

2 

6.  

Follow the 7 x 7 rule  

a. 7 x 7 rule means do not exceed 7 words per line, and 7 lines per slide. 

b. Follow the rule for the most part (exceptions here and there are fine).  

2 

7.  
Adjust font sizes and colors as appropriate.  It should be easy to read. For example, do not use a 
yellow font on a white background.  

2 
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Steps Part 1 - PPT Project Instructions Points 

8.  
Create an Overview slide. That is, after the first slide (title slide), the next slide should be titled 
Overview. It should contain a list of all the slides in your presentation. This gives the audience an 
overview of the presentation. 

2 

9.  

Add speaker notes to your Overview slide.  

Remember, this is why the 7x7 rule works. Use speaker notes when you want to convey more 
information than is on the slide. Print using Notes Pages, and then make sure and “talk” about 
“your notes” during your presentation! 

2 

10.  

Using Graphics Effectively: 

a. Insert at least 1 “Online Picture” and resize (if necessary) 

b. Change the Picture Style of the picture! 

2 

11.  

a. Insert a shape into a slide 

b. Enhance your shape by adding color and using a shape style.  

c. Now add text to your shape by adding a text box on the shape. 

3 

12.  Create a SmartArt on at least 1 slide 2 

13.  Create a Table in at least 1 slide 2 

14.  

The last slide of your presentation should be titled: “Contact Information”. This is a slide will give 
your audience information on how to get in contact with you at a later time, if necessary.  Your 
NAME, Your PHONE, and EMAIL must be on this slide (Note: you can put a fake phone number 
and email if you like). 

2 

15.  
Apply a transition to ALL slides. You can use the same transition on all slides, or a different 
transition for each slide. 

2 

16.  

Include (on all slides) a footer that includes: 

a. The date 

b. A slide number  

c. Footer text of: By: Firstname Lastname. Replace the word Lastname with your last name 
and replace Firstname with your first name. For example, if your name is Tom Jones, then 
your footer text would be:  By: Tom Jones. 

d. Check the box so that the footer does not show on the title slide! 

2 

17.  Be sure to check the presentation for spelling errors.  2 

18.  
• Save and Close the PowerPoint presentation. 

• You may now proceed to word project instructed below. 
0 

TOTAL POINTS 32 
 

NOTE: Make sure to view the (18PR) PPT Sample Solution.pdf link within this module to get some ideas on 

how to incorporate the features listed above into a PPT presentation. 
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Steps Part 2 - WORD Project Instructions Points 

19.  

Create a new Word document on your PC (or flash drive) named 18PR_word_LastFirst, where 

LastFirst is your actual Lastname and Firstname (For example, if your name is Mary Smith, you will 

name the file 18PR_word_SmithMary) 

1 

20.  

Enter the following text into your empty, newly created Word file:  

 

2 

21.  

Insert a Footer into the document with Your Name in the left section, today’s date in the center 
(choose any style but make sure it is NOT automatically updated) then, tab to the right section and 
insert a Page Number in the Current Position, choosing Accent Bar 1 style (see image below). 

Note: It is very important to choose Current Position after you select the Page Number drop-down 
arrow. 

 

2 

22.  

Add 4 blank lines into your file as follows (see image below): 

a. Move your cursor to the end of the second paragraph, Part 1: PowerPoint, and then press 
Enter to add a new blank line. 

b. Add three more new blank lines by pressing Enter after the following three paragraphs: 

Part 2: Word 

Part 3: Excel 

Part 4: Access 

 

2 

Press [Enter] key here 
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Steps Part 2 - WORD Project Instructions Points 

23.  

Add a heading title to your file as follows (see image below): 

a. Move your cursor to the top of the document by pressing Ctrl-Home and then Enter to create 
a new blank line at the top of the file.  

b. Press Ctrl-Home again to move to the top of the file and then enter the following text: BCIS 
PROJECT SUMMARY 

c. From the Home menu, in the Styles group, change the style of the heading text to the 
Heading 1 style. 

 

2 

24.  

Apply the Heading 2 style to the following four paragraphs (see image below): 

Part 1: PowerPoint 

Part 2: Word 

Part 3: Excel 

Part 4: Access 

 

2 
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Steps Part 2 - WORD Project Instructions Points 

25.  

Modify the Heading 1 and Heading 2 styles: 

a. Modify the Heading 1 style to be bold and centered. 
b. Modify the Heading 2 style to the Black, Text 1 color, and underlined. 

2 

26.  

Set the Before and After paragraph spacing: 

a. Move your cursor to the first body paragraph of the document, starting with: This document 
will contain 

b. On the Layout tab, in the Paragraph group, set the Spacing Before and the Spacing After to 
12 pt. 

At this point, the text in your document should look as follows (Note: You may have one or two blank 
lines at the end of the document. Either is fine.). 

 

2 
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Steps Part 2 - WORD Project Instructions Points 

27.  

Insert a picture into your word document as follows: 

a. Move the cursor to the blank line after: Part 1: PowerPoint 
b. Insert Online Pictures of your choice in into your Word document at the current location. 
c. Resize the image to have a Shape Height of 2”. 

At this point, your document should look similar to the following image (though the image will be 
image of your choice): 

 

2 

28.  

Create tabs as follows: 

a. Move the cursor to the blank line below Part 2: Word 
b. Enter the following text:  The following is a list of all the files in the Project and then press 

Enter. 
c. With the insertion point (cursor) on the new blank line, set the following tabs: 

i) Left Tab at 1" 
ii) Center Tab at 3" 

iii) Right Tab at 5.5" 
iv) Press the Tab key to position cursor at the first tab stop (1") and start entering the 

text shown in the image below making sure to: 

3 
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Steps Part 2 - WORD Project Instructions Points 

i. Enter the text at the appropriate tabs 
ii. Use the actual filenames, with your name included as part of the file names 

29.  

Format the text as follows: 

a. Select the text:  The following is a list of all the files in the Project  
i) Center the text 

ii) Apply the Cambria font with a 16pt font size 
 

b. Select the next line of text:  Application                File                    Extension  
i) Underline the text 

 

3 
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Steps Part 2 - WORD Project Instructions Points 

30.  

Create a table: 

a. Move the cursor to the blank line after Part 3: Excel 
b. Insert a 6-row, 3-column (3x6) table 
c. Apply any of the Grid Table 4 styles. 
d. Set the Table Column Width for the three columns to 2” each.  
e. Merge the cells in the first row 

i) Enter the following text in the first row: Files in BCIS Project 

ii) Center the text in the first row 
f. Apply any shading to the second row 
g. Add a border to the table 

Enter the following data, where the file names are your actual filenames, with your names included 
as part of the file names: 

 

3 

31.  

Create a SmartArt as follows: 

a. Move the cursor to the blank line after: Part 4: Access 
b. Insert a SmartArt Graphic 

i) Select the Accent Process SmartArt, in the Process category 

ii) Select the ENTIRE SmartArt (not just one shape), and in the SmartArt Tools Format 
tab, in the Size group, change the Height to 1” and the Width to 5” 

iii) With the ENTIRE SmartArt still selected, in the SmartArt Tools Design tab, in the 
Create Graphic group, Add Shape so there are 4 parts to the SmartArt 

iv) Add the following text to the SmartArt (see image below): 3 

32.  

a. Move the cursor (Insertion Point) to the beginning of the line: Part 3: Excel and insert a Next 
Page Section Break 

b. Set the orientation of this second page to Landscape 
2 
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Steps Part 2 - WORD Project Instructions Points 

33.  

When completed your word document should look similar to the following: 

 

0 

34.  
• Save and close the word document. 

• You may now proceed to the Excel project instructed below. 
0 

TOTAL POINTS 31 
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Steps Part 3 - EXCEL Project Instructions Points 

35.  

Create a new Excel workbook on your PC (or flash drive) named 18PR_excel_LastFirst, where 

LastFirst is your actual Lastname and Firstname (For example, if your name is Mary Smith, you will 

name the file 18PR_excel_SmithMary) 

1 

36.  

a. Enter the following data into cell range A1:F7 into Sheet1 worksheet of your empty, newly 

created Excel file 

b. AutoFit the column width for columns A through F 

Note: to AutoFit the columns, do not use the AutoFit Column Width menu option under Format. 

Instead, select the entire Sheet1 worksheet by clicking the diagonal down arrow 1 (left of column A) 

and simply position the mouse over the column line in the column headers, between any two 

columns so the cursor becomes a double headed arrow 2 and double-click so all columns will AutoFit 

at the same time. 

Below is a sample of what your file should look like at this time 

3 

37.  

Rename and Copy the worksheet as follows: 

a. Rename the Sheet1 worksheet to: Products 
b. Right-click the Products worksheet tab and select Move or Copy from the worksheet menu. 
c. The Move or Copy dialog box will appear. Under Before sheet: select (move to end) to 

place the worksheet to the right of the existing worksheet. 
d. Check the box next to Create a copy, then click OK. 
e. Rename the new worksheet to: Updated Products 

3 

38.  

In the Updated Products worksheet, add the following column headings: 

a. In cell G1 enter Profit per Unit 
b. In cell H1 enter Possible Discount  
c. In cell I1 enter Quantity  
d. In cell J1 enter Net Income 

3 

39.  

In cell G2, insert a formula to calculate the difference between the UnitPrice and the UnitCost.  

a. Use the fill handle to copy this formula down to row 7. 

NOTE: Verify formula result with the image in step 48 below 

3 

40.  

In cell H2, insert an IF function that displays a value of "Y" (when true) or "N" (when false) if the 

UnitCost (E2) is greater than or equal to 100. 

a. Use the fill handle to copy this formula down to row 7. 

3 

1 
2 
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Steps Part 3 - EXCEL Project Instructions Points 

NOTE: Verify function result with the image in step 48 below 

41.  

Enter the following data: 

a. In cell I2 enter 100 
b. In cell I3 enter 150 

c. In cell I4 enter 200 
d. In cell I5 enter 20 
e. In cell I6 enter 10 
f. In cell I7 enter 1 
g. In cell I9 enter Discount: 
h. In cell I10 enter Highest Value: 
i. In cell I11 enter Lowest Value: 
j. In cell I12 enter Sum: 

k. In cell I13 enter Average: 
l. In cell J9 enter 5 

NOTE: Verify data entered with the image in step 48 below 

3 

42.  

Format as follows: 

a. Autofit Column Width for column I 
b. Format J9 to Currency Number Format with 2 decimal places 

c. Select row 1 and Wrap Text which will display column headings in G1, H1 and J1 as multiple 
lines within the cell. 

d. Select the column headings A1:J1 and apply Cell Style of Heading 3. 

NOTE: Verify formatting with the image in step 48 below 

3 

43.  

In cell J2, insert an IF function that calculates the value for Net Income as follows: 

a. If the Possible Discount (H2) is equal to "Y",  

i) (true) The gross income is the (Profit per Unit-Discount) multiplied by the Quantity 

(G2-$J$9)*I2 

ii) (false) Or else, the gross income is the Profit per Unit multiplied by the Quantity. 

b. Use the fill handle to copy this formula down to row 7. 

c. Format the cells in J2:J7 to Currency Number Format with 2 decimal places 

NOTE: Verify function result with the image in step 48 below 

3 

44.  

Use appropriate functions to do the following: 

a. In cell J10 enter a function to display the highest value for the range J2:J7 

b. In cell J11 enter a function to display the lowest value for the range J2:J7 

c. In cell J12 enter a function to sum the cells in the range J2:J7 

d. In cell J13 enter a function to average the cells in the range J2:J7 

NOTE: Verify function results with the image in step 48 below 

3 

45.  

Insert a 3-D Clustered Column chart (see image in step 48 below) as follows: 

a. Simultaneously select the following data: B1:B7, D1:D7, E1:E7, G1:G7, I1:I7 

b. Insert a 3-D Clustered Column chart 

c. Move and resize the pie chart so that it is located in cells B9:G23  

d. Change the Chart Title to Excel Project 

e. Change the Chart Style to Style 6. 

3 
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Steps Part 3 - EXCEL Project Instructions Points 

f. Remove the data labels as follows: 

i) On the Chart Tools Design tab, in the Chart Layouts group, click Add Chart Element, 

click Data Labels, and select None. 

46.  

Change the Page Layout of the Updated Products worksheet so that it (see image in step 48 below): 

a. Is set to Landscape orientation and 

b. Will FIT to one Page, and 

c. Has a Customer Header with Your Name in the left section, Sheet Name in the center 

section, and Current Date on the right section, and 

d. Will print with Gridlines. 

e. Will print with Row and column headings 

3 

47.  

When completed, the Updated Products worksheet should look similar to the following: 

0 
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Steps Part 3 - EXCEL Project Instructions Points 

48.  

Creating a new worksheet and using VLOOKUP: 

a. Copy the data from the Products worksheet to a new worksheet named: Vlookup  

i) Note: See step 38 for information on how to copy data from one worksheet to another 
b. Enter the following text  

i) In cell G1: Handling Fee 

ii) In cell A12: Category 

iii) In cell A13: AT 

iv) In cell A14: DE 

v) In cell A15: MD 

vi) In cell A16: WD 

vii) In cell B12: Handling Fee in Dollars 

viii) In cell B13: 0 

ix) In cell B14: 2 

x) In cell B15: 5 

xi) In cell B16: 10 
c. AutoFit the column width for column G 

d. In cell G2, insert a VLOOKUP function that determines the correct handling fee as follows: 

i) The function will refer to the Lookup_value in C2 

ii) The function with use the Table_array A12:B16 (though it will need to be absoluted so 
that each row will reference the same table array once it’s copied) 

iii) The function will take the value from the table array from column 2 

iv) The function must contain a Range_lookup of FALSE so that the categories are identical 
matches between the table array and the main data (if not, AT could be matched in 
more than one place … ask your instructor to explain this) 

e. Use the fill handle to copy this formula down to row 7. 

f. Format G2:G7 to Currency Number Format with 2 decimal places 

 

3 

49.  • Save and close the excel workbook. 0 

TOTAL POINTS 37 
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Steps Part 4 - ACCESS Project Instructions Points 

50.  

You may now proceed to your Canvas course to upload/submit the following project solution files 
saved on your PC: 

o 18PR_ppt_LastFirst.pptx 

o 18PR_word_LastFirst.docx 

o 18PR_excel_LastFirst.xlsx 

0 

TOTAL POINTS 100 
 


